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SAŽETAK 

Od svoje pojave, još u ranoj povijesti, fotografija je postigla efekt superiornosti pri 

oblikovanju vizualne poruke. Zahvaljujući vjernom bilježenju informacija, postala je 

omiljeni medij ali i način izražavanja onoga tko stoji iza kamere. U svakodnevnom životu, 

fotografija se susreće kao samostalni nositelj poruke, ali je još češće u funkciji dodatnog 

sadržaja određenog teksta ili grafičkog elementa. U tom slučaju kategorizira se kao 

ilustracija. 

Ovaj diplomski rad će predstaviti fotografiju kao ilustraciju literarnog rada. U teorijskom 

dijelu, protumačiti ću reprodukciju fotografije na  tiskanom mediju, a u eksperimentalnom 

dijelu ću realizirati zbirku pjesama obogaćenu vlastitim fotografijama kao glavnim  

vizualnim jezikom. Važno je naglasiti da se radi o realiziranom autorskom djelu - zbirka 

poezije „Nešto kao… sjećanja“ je objavljena od strane Hrvatskog kulturnog društva 

„Napredak“ te se može pronaći na policama knjižnica. 

Ključne riječi: fotografija, tisak, Photoshop, Indesign  

 

ABSTRACT 

Since its appearance, even in the early history, photography achieved superiority effect in 

shaping the visual message. Thanks to the accurate recording of information, it has become 

a favorite medium of expression and manner of one who stands behind the camera. In 

everyday life, photography is encountered as an independent carrier of messages, but more 

often as a function of the additional content, specific text or graphic element. In this case, 

it's classified as an illustration. 

This final work will present the photography as an illustration of the literary book. In the 

theoretical section, I will explain the reproduction of images on print media, and in the 

experimental part will be realized collection of songs enriched with my own photographs as 

the main visual language. It is important to emphasize that this is realized author work - a 

collection of poetry, "Something like ... Memories" was published by the Croatian Cultural 

Society „Napredak“ and can be found on the shelves of libraries. 

Key words: photography, press, Photoshop, Indesign  
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1.UVOD 

Stvaranje knjige je dugotrajan i kompleksan proces jer okuplja krug ljudi različite struke. 

Tako je i zbirka poezije „Nešto kao... sjećanja“ na početku bila samo rukopis kojeg je autor 

želio otisnuti, komercijalizirati i predstaviti široj publici. Za to mu je trebala pomoć počevši 

od nakladnika, urednika, lektora, recenzenta i tako dalje do grafičkog dizajnera zaslužnog 

za likovno osmišljavanje i oblikovanje. 

Autor je već ranije zamislio knjigu u obliku ekskluzivnog izdanja karakterističnog izgleda i 

obogaćenu crno bijelim umjetničkim fotografijama. Vođen tim konceptom, diplomski rad će 

sistematski predstaviti faze izrade knjige te opisati radnje za obradu fotografija i prijelom 

teksta. No, praktičnom dijelu prethodi definiranje osnovnih pojmova za razumijevanje 

cjelokupnog procesa pripreme dokumenta za tisak.  

Fotografije koje će ići u zbirku trebaju prvenstveno zadovoljavati estetske kriterije ali 

tehničke uvjete kako bi bile spremne za otiskivanje. U cilju pravilne pripreme za tisak, 

teoretski dio će objasniti pojmove vezane za pripremu fotografije: rezolucija, format i 

prostori boja ali i pojmove vezane za tisak dokumenta. Nakon teoretskog, uslijediti će 

eksperimentalni dio diplomskog rada koji će se usredotočiti na proizvodnju konkretnog 

proizvoda. Kroz razne opcije Adobovih programa, redom će biti opisane operacije potrebne 

za stvaranje zbirke poezije - počevši od odabira i selekcije fotografija pa sve do otiskivanja i 

realizacije spomenute knjige. 
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2.TEORIJSKI DIO 

2.1. Usporedba analogne i digitalne fotografije 

Fotografiranje je tehnika digitalnog ili kemijskog zapisivanja prizora iz stvarnosti na sloju 

materijala koji je osjetljiv na svjetlost. Zrake padaju na fotografski film ili digitalni senzor te 

tako ostavljaju precizan odraz prirode, isječak prostora i zaustavljeni trenutak vremena. 

Produkt fotografiranja je fotografija kao autentično djelo. Zbog toga je jasno da je 

fotografija, između ostalog, i grana umjetnosti a fotograf umjetnik koji na poseban način, uz 

znanja, vještine i intelektualni napor,  bilježi svijet oko sebe te se kroz fotografiju kreativno 

izražava. 

Klasična, odnosno analogna fotografija, koristi osjetljivi fotografski film na kojem svjetlost 

ostavlja svoj trag. Za obradu i stabilizaciju slike su potrebni kemijski postupci u laboratoriju. 

Dakle, u klasičnom fotografskom stvaralaštvu, obrada slike se obavlja kemikalijama i 

kemijskim procesima tako da se mijenjaju supstance koje tvore sliku. Ova činjenica vodi do 

osnovne razlike između klasične i digitalne fotografije. [1] 

U oba slučaja slika nastaje zahvaljujući fotoelektričnom efektu, no u digitalnoj fotografiji 

sliku stabiliziramo matematičkim operacijama jer je ona prikazana kao skup binarnih 

podataka. Tako digitalna slika i nije ništa drugo nego skupina brojeva pohranjena na 

odgovarajući medij. Za razliku od analogne fotografije, fotoosjetljivi materijal nije film već 

elektronički senzor-CCD. To je mali silikonski čip koji sadrži tisuće, milijune, na svijetlo 

osjetljivih elemenata slike koji se zovu pikseli. Svjetlo koje pada na piksel izaziva stvaranje 

električnog napona, koji se pretvara u niz digitalnih podataka razumljivih računalu. Što više 

piksela sadrži CCD, to je veća rezolucija fotografije. Ona se upisuje u memorijsku jedinicu 

koja je neka vrsta diska ili magnetske kartice što omogućava spremanje slike na osobnom 

računalu kao digitalne datoteke koju je moguće pregledati, uređivati, manipulirati, 

arhivirati ili ispisati. Upravo je zbog skraćenog i jeftinijeg procesa izrade, digitalna 

fotografija ostvarila prednost pred analognom. Važna prednost je i ta što digitalni 

fotoaparati pružaju snimke vidljive na zaslonu fotoaparata bez razvijanja. Fotografije se 

mogu odmah brisati ili spremiti na memorijsku karticu koja ima puno više kapaciteta od 36 

slika standardnog fotografskog filma. Pojednostavljen je i proces pohranjivanja, jer se 

fotografije mogu brzo slati i dijeliti drugim računalima te pomoću interneta dospjeti bilo 

gdje na svijetu. Još jedna korisna činjenica kod digitalnih fotoaparata je ta da oni bilježe 

dodatne podatke o fotografiji (ekspozicija, ISO osjetljivost, datum, model fotoaparata).  
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Većina fotografa, pogotovo iskusnih računalnih korisnika, koristi digitalni fotoaparat. Ipak, 

profesionalci često imaju podijeljena mišljenja o kvaliteti digitalnog fotografskog 

stvaralaštva zbog velikih mogućnosti digitalne obrade. 

 

2.2. Priprema fotografije za reprodukciju 

2.2.1. Obrada digitalne fotografije 

Kao što se u analognoj fotografiji film razvija kemijskim putem prije prenošenja na foto 

papir, tako se digitalni snimljeni podaci obrađuju kompjuterski. Nakon snimanja i odabira 

najboljih fotografija slijedi obrada fotografija u nekom od grafičkih programa.  

U vrijeme filma i klasičnih fotomaterijala u laboratoriju su se koristila razna sredstva i 

tehnike za jači intenzitet boje, određene efekte, kontrolu svjetline, kontrasta i slično. Za 

razliku od analogne, fotografija snimljena digitalno je rasterska slika pohranjena kao mreža 

piksela koji sadrže informacije o boji, svjetlini i ostalim postavkama. To znači da se 

matematičkim operacijama koje obavlja elektronički uređaj brzo i jednostavno mijenjaju 

njene brojčane vrijednosti. Za tu svrhu se koriste vektorski i rasterski grafički softveri. 

Postoji čitav niz raznih grafičkih programa, od onih jednostavnih u kojima je moguće vršiti 

okretanje ili mijenjanje dimenzije slike, korigiranje boje i kontrasta slike pa sve do veoma 

kompleksnih programa koji sadrže složene algoritme s kojima je moguće napraviti i puno 

više. Za osnovne radnje nad slikama može poslužiti bilo koji preglednik - najčešće svi imaju 

osnovne alate za korekciju. Međutim, ako je slici potrebna veća i složenija korekcija, 

potrebna je instalacija posebnih alata za obradu. 

Poznati rasterski grafički programi su Adobe Photoshop, Paint Shop Pro i potpuno besplatni 

GIMP dok su vektorski Freehand, Corel Draw te najpopularniji Adobe Illustrator. 

 

2.2.1.1. Adobe Photoshop 

Adobe Photoshop je najmoćniji softver za digitalno obrađivanje slika. Prva verzija ovog 

profesionalnog alata izašla je u veljači 1990. Godine, no zbog svestranosti te mnoštva opcija 

koje nudi, Photoshop je ubrzo nakon postao najpopularniji program za obradu slika. 

Njegovo korištenje postalo je osnovnim znanjem svakog profesionalnog fotografa ili 

http://bs.wikipedia.org/wiki/Vektorska_grafika�
http://bs.wikipedia.org/wiki/Rasterska_grafika�
http://bs.wikipedia.org/wiki/Grafi%C4%8Dki_softver�
http://bs.wikipedia.org/wiki/Algoritam�
http://bs.wikipedia.org/wiki/Rasterski_grafi%C4%8Dki_programi�
http://bs.wikipedia.org/wiki/Adobe_Photoshop�
http://bs.wikipedia.org/w/index.php?title=Paint_Shop_Pro&action=edit&redlink=1�
http://bs.wikipedia.org/wiki/GIMP�
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grafičkog dizajnera. Čini se da je svaka fotografija u časopisu ili plakatu prošla kroz Adobov 

Photoshop, pa je tako i laiku poznat glagol „fotošopirati“.  

Instalacija programa je standardna, a sučelje napredno za početnike. Neke od funkcija koje 

služe pri osnovnom editiranju fotografije su podešavanje tonova  pomoću histograma, 

kontroliranje dinamičkog raspona slike pomoću nivoa, poboljšanje kontrasta uz pomoć 

krivulja, korekcija svjetline, zasićenosti boja i tako dalje. Također je moguće slici dodavati 

različite efekte i filtre, često korišteni od strane fotografa početnika.  

U Photoshopu fotografija može biti prikazana preko više slojeva (layera) pa je tako moguće 

editiranje samo jednog sloja ili selektiranog dijela nekog sloja. Za to služe maske, koje 

uvelike pospješuju i otvaraju razne mogućnosti pri obradi fotografije. Može se zaključiti da 

se umijećem „fotošopiranja“ dobila potpuna kontrola nad slikom. Čak se kaže da je 

fotografija sve manje "prava" i "istinita", jer se digitalnom obradom može dobiti gotovo sve 

što je fotograf  prethodno zamislio u glavi. Zbog tog razloga je fotografija posljednjih 

desetljeća doživjela veliku promjenu u tehnološkom ali i u umjetničkom smislu pa neki 

smatraju da je upravo Adobov Photoshop poljuljao osnovna načela fotografske slike u 

klasičnom smislu. No, vrijedi napomenuti da je većina alata korištenih u dotičnom 

programu dobilo ime ili simbole prema tehnikama iz tamne komore. Tako su, primjerice, 

često korišteni alati „Dodging and Burning“ i „Unsharp mask“ izvedeni iz tehnika izoštravanja 

u tamnoj komori. Gledajući iz tog kuta, obrada fotografije je oduvijek postojala, no digitalna 

obrada je cijeli proces revolucionarno pojednostavila, ubrzala i proširila mogućnosti. 

 

2.2.1.2. Odabir rezolucije fotografije 

Kvaliteta digitalne slike, bila ona otisnuta na papiru ili prikazana na monitoru računala, 

ovisi o njenoj rezoluciji. Rezolucija ili razlučivost slike označava broj piksela korištenih za 

oblikovanje slike po jedinici površine.  

Piksel je najmanji neovisni element svjetlosnog senzora (čipa) koji svjetlosni podražaj 

pretvara u električni impuls, ali također i najmanji neovisni izlazni element ekrana ili 

monitora. Označava rezoluciju senzora ili ekrana, a može označavati i veličinu slike. [2] 
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Pikseli se mogu usporediti sa zrnom1

Da bi fotografija dobro ispala u tisku trebala bi imati najmanje 300 dpi. Dpi (dots per inch) 

označava broj točaka po inču i njome se najčešće izražava rezolucija fotografije spremne za 

tisak. Postoji još i ppi (pixels per inch) koji izražava rezoluciju prikazanu na monitoru. Te 

dvije veličine su zapravo analogne jer označavaju gustoću informacija sadržanih u slici, a 

nazvane su različito iz praktičnog razloga - da bi se izbjegle zabune i za lakše prepoznavanje 

medija na kojem se slika prikazuje. Znači, potrebna rezolucija slike za tisak je 300dpi, dok je 

standard fotografije koja se prikazuje, recimo na internetu 72ppi. 

 na klasičnoj (analognoj) fotografiji. Takvom 

usporedbom se zaključuje da veći broj manjih piksela daje bolje detalje na fotografiji te 

oštrije, manje mutne rubove. 

Ako su dimenzije fotografije neodgovarajuće i premale, računalne aplikacije omogućuju 

povećanje rezolucije iznad stvarne rezolucije dodavanjem dodatnih piksela. Taj proces se 

zove interpolacija, a koristi komplicirane matematičke algoritme kojima računalo poveća 

rezoluciju ali i smanji oštrinu fotografije. 

 

2.2.1.3. Modeli za prikaz boja 

Modeli za prikaz boja koriste numeričke vrijednosti kako bi predstavili vidljivi spektar. 

Izlazni uređaji, poput ekrana računala ili tiskarskog stroja čitaju boje na različite načine pa 

je nužno svaku od njih pravilno definirati. Tako boje prikazane na ekranu imaju drugačiju 

metodu opisivanja, odnosno prikaz, nego boje pomiješane na otisku. U svakom od modela  

(prostora), boje su definirane preko kanala - brojčanih prezentacija boja. 

Postoje dva osnovna načina miješanja boja a to su aditivna sinteza i suptraktivna sinteza. I 

jedan i drugi način se temelji na trikromatskom principu reprodukcije boja, a razlika je 

samo u načinu na koji se ta sinteza vrši. Aditivna sinteza se temelji na zbrajanju odnosno 

dodavanju pojedinih valnih duljina. Ovu metodu je najjednostavnije opisati pomoću 

zbrajanja tri snopa svjetlosti, crvene , zelene i plave. Suptraktivna sinteza se temelji na 

apsorpciji odnosno oduzimanju pojedinih valnih duljina od bijele svjetlosti. Selektivno 

uklanjanje valnih duljina vrši se pomoću filtera. Zelenoplavim filterom se oduzima crveni, 

purpurnim se oduzima zeleni, a žutim plavi dio spektra. [3]  

                                                            
1 Zrno – zrnca srebrenih halogenida koja tvore fotografski film 
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U slučaju aditivne sinteze misli se na RGB (red, green, blue) prostor boja. Ovaj prostor boja 

koristi računalo i senzor digitalnog aparata koji prikazuju boje preko tri kanala. Važno je 

naglasiti da je u ovom spektru bijela boja rezultat miješanja maksimalnih vrijednosti tri 

osnovne boje, a crna nedostatak vrijednosti u svakom od kanala (Slika 1). 

Tiskarski strojevi boje prikazuju preko CMYK prostora boja. Tako se originalna fotografija u 

pripremi za tisak rastavlja na 4 izvatka: plavozeleni (cyan), purpurni (magenta), žuti (yellow) i 

crni (karbon). Za razliku od RGB-a, u ovom slučaju dolazi do supraktivne sinteze pa bijela 

nastaje nedostatkom, a crna miješanjem tri osnovne boje. Sve četiri boje nazivaju 

se procesnim bojama s obzirom na to da predstavljaju standardne boje koje se koriste za 

višebojni tisak. 

Model koji pokušava opisati boje na osnovi ljudske percepcije je HSB prostor boja.  Opisuje 

tri osnovne karakteristike boje ton (hue), zasićenost (saturation) i svjetlinu (brightness). 

CIE Lab model definira boju trodimenzionalno preko svjetline L (lightness) i dvije kromatske 

komponente a i b. Prva komponenta opisuje vrijednosti od zelene do crvene, a druga od 

plave do žute. Model je oblikovan s ciljem postojanosti prikaza boje na bilo kojem uređaju. 

Postoji još jedan model važan spomenuti. To je grayscale model, koji prikazuje postotak crne 

boje od 0% do 100%. Vrijednost 0% predstavlja bijelu boju, vrijednost 100% crnu boju, a sve 

nijanse između su nijanse sive boje. 

Odabir modela ovisi o namjeni dokumenta. Pri reprodukciji fotografije, odluka pada na 

CMYK spektar, jer je višebojni tisak pretežno trikromatski reprodukcijski proces gdje je 

svaka boja opisana vrijednostima tri osnovne boje: plavozelene, purpurne i žute. U praksi se 

često dodaje još i četvrta boja - karbon crna. Razlog je taj da se miješanjem tri osnovne boje 

dobiva tamnosmeđa te se mora kombinirati s crnom kako bi se dobila prava „duboka“ crna. 

Fotografija koja će se tiskati, prethodno mora biti obrađena u Photoshopu jer je s izlaznog 

uređaja (fotoaparata), stigla u RGB prostoru boja. Piksel slike posjeduje dodijeljenu 

vrijednost za svaku od tri RGB komponente. Kada se u Photoshopu, jednostavnim alatom 

prebaci fotografija iz jednog modela u drugi, točnije u CMYK model spreman za tisak, 

svakom pikselu je dodjeljena vrijednost od 4 komponente. Inače, prevođenje boja iz jednoga 

u drugi model uvijek donosi gubitke u kvaliteti, jer matematički algoritmi biraju najsličnije 

ali ne i identične zamjene. 
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Slika 1 Prikaz aditivne i suptraktivne sinteze 

 

2.2.1.4. Formati zapisa digitalne fotografije 

Pri obradi digitalne fotografije nameće se pitanje odabira zapisa slikovne datoteke. Jedna od 

najčešćih nedoumica je ta treba li fotografiju komprimirati i koju kompresiju pritom 

koristiti. Kompresija je zapravo sažimanje podataka kako bi se smanjio memorijski prostor 

fotografije. Zbog toga komprimirani formati generiraju značajno manje datoteke, čak 2 do 3 

puta manje od originalne datoteke. Postoje mnogi formati u kojima je moguće sačuvati 

sliku, no odabir ovisi prije svega o njezinoj konačnoj namjeni. Zbog svojih posebnih 

zahtjeva, formati datoteka koje se koriste u stolnom izdavaštvu, kao na primjer tisak knjiga, 

se razlikuju od formata koji se koriste, primjerice, za web sadržaje. Fotografija u knjizi 

zahtjeva puno veću kvalitetu od one objavljene na internetu. 

Najvažnija karakteristika koja razlikuje načine kompresije je sažimanje s gubitkom kvalitete 

(lossy) ili bez gubitka kvalitete (lossless). Formati bez gubitaka osiguravaju kompletnu 

informaciju o fotografiji dok ostali formati gube neke slikovne informacije osiguravajući 

tako manje datoteke. Fotografije u tim zapisima nisu više identične originalnoj fotografiji.  

Postoje mnogi formati zapisa digitalnih slika no u digitalnim fotoaparatima tri su 

uobičajena - TIFF, RAW i JPEG. Nakon što se fotografija ubaci u neki od grafičkihprograma, 

primjerice Photoshop, moguće ju je spremiti u zapis pogodan za tisak ili za sadržaje za web, 

prezentacije i slično. Najčešći korišteni formati slikovnih datoteka su: RAW, JPEG, GIF, PNG, 

TIFF i EPS. 
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RAW 

RAW je vrsta zapisa slikovnih datoteka u kojemu fotoaparat sprema sve podatke koje je 

digitalni senzor zabilježio, bez posebne obrade u procesoru digitalnog aparata. On sadrži 

direktne, neprocesirane podatke te se još zove i sirovi format ili digitalni negativ. 

RAW pruža najvišu moguću kvalitetu slike koju može zabilježiti digitalni fotoaparat pa je 

često jedini izbor profesionalnih fotografa. Zbog bogatih i detaljnih podataka o slici, ovaj 

format zauzima dosta memorijskog prostora. Međutim, najveći mu je nedostatak taj što nije 

univerzalni format već zahtjeva posebne računalne programe. Takva fotografija na računalu 

nije upotrebljiva; ne može se koristiti u dokumentima, nije ju moguće objaviti na internetu i ne 

može se otisnuti dok se naknadno ne obradi i snimi u komprimiranom obliku.  To znači da se 

RAW zapis u pravilu prvo mora otvoriti u nekom od RAW konvertera te ga prevesti u čitljivi, 

univerzaliji format. No, važno je naglasiti da je raw konverter poprilično napredan alat za 

obradu slike jer od neprocesuiranih podataka može „spasiti“ fotografiju od šuma, loše 

ekspozicije, krivog balansa bijele boje, može korigirati izoštravanje, kontrast, zasićenje boje 

i slično.  

 

Slika 2 Odabir formata fotografije na zaslonu Nikon aparata 
http://ljeto.net.hr/2009/05/17/0303007.39.jpg 

 

JPEG 

JPEG je standardni, najuobičajeniji i najpopularniji format za kompresiju digitalnih slika. 

Prednost formata leži u sposobnosti algoritma da veoma dobro sažima informacije u 

fotografiju koja na prvi pogled nema vidljivih gubitaka koji inače nastaju uslijed JPEG 

kompresije. Datoteke su relativno male, na medij se pohranjuju brzo te sve platforme 
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podržavaju ovaj format zapisa. Fotografije u JPEG-u su namijenjene, ovisno o stupnju 

kompresije, od složenih profesionalnih primjena do sasvim jednostavnih kao što su 

prezentacije, prikazi na monitoru, sadržaji na internetu i slično.  

JPEG je tzv. lossy format kojim se ne može povratiti originalna slika jer se uslijed obrade gubi 

izvornost podataka; prilikom sažimanja dolazi do smanjenja broja boja i do nepovratnog 

gubitka informacija. Ipak, zahvaljujući svojem kvalitetnom algoritmu za kompresiju, 

fotografije u JPEG-u zadržavaju prirodnost prizora te se kao takve mogu koristiti za manje 

kvalitetne reprodukcije. 

Mnogi fotoaparati, pogotovo oni profesionalniji, imaju mogućnost kombiniranja zapisa 

RAW+JPEG (Slika 2), što može biti dosta praktično, jer se važnije fotografije ostavljaju u RAW 

formatu, a one manje važne u JPEG-u. Na taj se način smanjuje opterećenje memorijske 

kartice te se pridonosi brzini. 

GIF 

Slike zapisane u ovom formatu nisu podobne za kvalitetno prikazivanje fotografija, jer je 

GIF format ograničen samo na 256 boja. Glavna prednost GIF-a leži u  relativno malom 

zapisu te mogućnosti animacije pomoću više sličica (frame). U potpunosti je podržan na 

webu, dok ni u kojem slučaju, nije pogodan za tisak. 

PNG 

PNG je najkvalitetniji zapis u RGB prostoru jer podržava veće palete boja od GIF-a te 

omogućava prikaz prozirnosti. No, s obzirom da podržava samo RGB, nije pogodan za tisak. 

TIFF 

TIFF predstavlja standard u grafičkoj industriji za pohranjivanje predložaka koje sadrže 

samo rastersku grafiku, a to su prvenstveno fotografije. Optimalan je format za aplikacije 

namijenjene pripremi za tisak jer u svom zapisu omogućava pohranjivanje krivulja, kanala, 

slojeva (layeri) i transparencije. Dakle, ako se TIFF fotografija importira u Photoshop ona će 

biti prikazana kao više slojeva, a svaki će se sloj moći zasebno obrađivati. Prilikom 

spremanja ovaj format nudi više opcija kompresije pa tako i LZV kompresiju koja slovi kao 

kompresija bez gubitaka (loseless compression). Neki digitalni fotoaparati posjeduju 

mogućnost obrade i zapisa upravo u TIFF-u. 
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Najveća prednost ovog formata je mogućnost korištenja na svim računalnim platformama 

poput Microsoft Windows-a i Macintosh-a ali i u svim programima za obradu fotografija. 

Također se koristi za skeniranje slika jer podržava sve veličine, rezolucije i dubine boja.  

Najveći nedostatak je taj što je TIFF datoteka puno veća u odnosu na, primjerice, JPEG 

format. Zbog tog razloga, format nije praktičan za uobičajenu uporabu. 

EPS 

EPS je obavezan format ako slika sadrži podatke o rasterskoj i vektorskoj grafici. Čitljiv je u 

gotovo svim grafičkim aplikacijama, a sam format podržava gotovo sve prostore boja. Za 

razliku od TIFF-a koji bi rastrirao vektorsku grafiku, EPS omogućuje zapis informacija o 

vektorima. Najbolji primjer je fotografija na kojoj je postavljen neki tekst. TIFF bi takvu 

fotografiju rastrirao zajedno s fontom, dok EPS format zadržava podatke o fontu. Može se 

zaključiti da ovaj format koristi kombinaciju PostScripta2

 

 i TIFF-a. 

2.3. Tisak digitalne fotografije 

2.3.1. Odabir tiska 

Pri odabiru tiskarske tehnologije, prvenstveno treba voditi računa o nakladi. 

Konvencionalni ofsetni tisak je isplativiji za veću nakladu, dok za manje naklade odabir 

uvijek pada na digitalni tisak.  

 

2.3.2. Rastriranje 

Raster je sredstvo pomoću kojeg se višetonska slika, u ovom slučaju fotografija, pretvara u 

jednotonsku. Premda ljudsko oko vidi otisnutu fotografiju u više tonova, ona je zapravo 

jednotonska - rasterski elementi od kojih je načinjena su toliko mali da oko vidi više od dva 

tona. Ovisno o samoj veličini rasterskog elementa, promatrač će imati dojam svjetlijeg ili 

tamnijeg tona. 

Osnovna karakteristika rastera je linijatura. Definirana je brojem linija po centimetru. Što je 

broj linija veći to je finoća rastera bolja, a reprodukcija kvalitetnija. Tako je nastala podjela 

                                                            
2 Postscript – programski jezik namijenjen vektorskom opisu 
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na grubi raster (do 30 lin/cm), srednje fini raster (30-60 lin/cm) i fini raster (iznad 60 

lin/cm). 

Da bi se dobila što kvalitetnija reprodukcija fotografije, finoća rastera mora biti što veća. 

Takva linijatura zahtjeva i visoku glatkoću papira, jer se u suprotnom ne bi mogle 

reproducirati male rasterske točkice. Inače, u ofsetnom tisku se crno bijeli tonovi slike, 

reproduciraju s linijaturom rastera 60 lin/cm, a višebojni s 80 lin/cm. Na kvalitetu 

reprodukcije također utječe i oblik rasterskog elementa.  

 

2.3.3. Ofsetni tisak 

Najveća razlika između ofsetnog i digitalnog tiska je način pripreme podataka. Kod ofseta se 

vrši separacija boja, što znači da svaka boja zahtjeva zasebnu tiskovnu formu. To uvelike 

poskupljuje proces, pogotovo kada se radi o višebojnom tisku. Tiskovna forma se izrađuje 

pomoću CTP-a (Computer to plate).  

Ofset je indirektna tehnika plošnog tiska. Kod njega se princip otiskivanja svodi na razlici u 

fizikalno - kemijskim svojstvima tiskovne forme. Osvijetljena aluminijska forma se montira 

na cilindar ofsetnog stroja na koju se nanosi boja, a otisak je moguć zahvaljujući oleofilnosti 

tiskovnih elemenata, odnosno oleofobnosti slobodnih površina. Prethodno se na tiskovnu 

formu nanosi otopina za vlaženje pa oleofilni elementi (tiskovni elementi) odbijaju vodu te 

se na njih prihvati samo masna boja, dok oleofobne površine ostaju neobojene. Na svim 

tiskovnim površinama se nalazi jednak nanos boje, što otisak čini boljim a tisak 

kvalitetnijim.  

Originalna fotografija je višetonski prikaz te ju je za ofsetni tisak potrebno pretvoriti u 

jednotonsku rastersku sliku. Rasterska slika ima samo dva tona (Dmin i Dmax), za razliku od 

višetonske koja sadrži niz tonova od najsvjetlijih do najtamnijih, a opisuju se rasponom 

gustoće zacrnjenja kojim je definiran i kontrast (ΔD = Dmax – Dmin).  
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2.3.4. Digitalni tisak 

Bezkontaktni ili digitalni tisak, pojavio se najkasnije te je usko vezan s razvojem računala i 

kompjuterizacije. Kvaliteta otisaka je u pravilu nešto niža od kvalitete otisaka ofseta, no 

glavna mu je prednost što se kod digitalnog tiska prijenos podataka obavlja direktno s 

računala. To daje mogućnost personalizacije i korekcije svakog otiska, što je kod 

konvencionalnih tehnika nemoguće, jer one koriste stalnu tiskovnu formu. Kod digitalnog 

tiska se rastriranje slika i separacija boja obavlja se u samom stroju te takvi podaci vode 

laser za oslikavanje tiskovnog cilindra. Na njemu se nalaze površine koje se međusobno 

razlikuju u električnom potencijalu; tiskovne površine su manjeg, a slobodne površine 

većeg potencijala. Prilikom svakog okretaja, tiskovni cilindar se ponovno nabija i izbija a 

boja koja se nalazi u spremištima i pumpama se automatski nanosi. Na taj način je moguće 

na istoj tiskovnoj jedinici dobiti četverobojni obostrani tisak. 

Najznačajnije i najrasprostranjenije tehnike digitalnog tiska su elektrofotografija i tintni 

pisač (inkjet). Princip elektrofotografije jako podsjeća na princip rada aparata za kopiranje. 

Kod aparata za kopiranje svijetlo žarulje se odbija od stranice koju kopiramo i pada na 

temeljni bubanj koji pod utjecajem svjetla postaje vodič elektriciteta. Kod digitalnih uređaja 

na temeljni bubanj pada lasersko svjetlo vođeno signalom iz kompjutora. Naboj prethodno 

narinut na bubanj se na osvijetljenim mjestima izbija i tako razlikom potencijala na bubnju 

nastaje latentna tiskovna forma. Na nju se nanese toner koji se zbog električnog naboja 

prihvaća samo za tiskovne elemente, a zatim se sa tiskovne forme toner direktnim ili 

indirektnim putem prenosi na tiskovnu podlogu. [4] 

Kod konvencionalnih tehnika, zbog troškova izrade tiskovne forme, male naklade imaju 

visoku cijenu po otisku pa su tako isplative samo velike naklade. Kod digitalnog tiska je 

cijena svakog otiska skoro jednaka, što daje prednost kod malih naklada, ali i nedostatak za 

tisak većih naklada. 

 

2.4. Oblikovanje knjige  

Postoje četiri osnovne faze stvaranja za sve proizvode: zahtjevi, dizajn, razvoj i testiranje. 

[5] Podjela je preuzeta iz knjige „Products in Half the Time“ te je u ovom diplomskom radu 

poslužila za lakše sistematiziranje pojedinih aktivnosti vezane za realizaciju zbirke poezije. 
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Zahtjevi 

Na samom početku oblikovanja, potrebno je istražiti zahtjeve dotičnog grafičkog proizvoda, 

u ovom slučaju, knjige. Oni se otkrivaju kroz interakciju grafičkog dizajnera prema klijentu, 

ciljanoj skupini i specifičnoj publici. Potrebne su povratne informacije što knjiga treba 

predstavljati i kome će koristiti. Može se zaključiti da je prvi pristup prema knjizi 

upoznavanje dizajnera sa sadržajem rukopisa. Procjenjujući kome je rukopis namijenjen, 

postavljaju se temeljne smjernice dizajna. [6] 

 

Dizajn 

Prethodno predstavljeni zahtjevi moraju se početi prevoditi u formu. Knjiga posjeduje svoju 

funkcionalnu narav, ali je potrebno da bude i skladno oblikovana. U ovoj fazi je potrebna 

najveća kreativnost, jer u njoj dizajner gradi skice na kojima će se temeljiti finalno rješenje 

knjige. Zato se može reći da je koncepcija ili ideja u prvom redu rezultat osobnosti kreatora, 

njegovog nadahnuća i nadarenosti. Skicama obično prethodi pažljivo istraživanje postojećih 

rješenja, a metodama pokušaja i pogreške dobiva se završni dizajn. Poznati grafički dizajneri 

se slažu u tvrdnji da dizajn koji je na početku i na kraju ove faze isti, nije izvrstan dizajn, jer 

je nedovoljno razrađen i testiran. [6] 

  

Razvoj 

Cilj razvojne faze je konačan proizvod. Kako bi proces išao u pravom smjeru potrebno je 

odrediti parametre oblikovanja knjige; format knjige, tipografija, paleta boja, kompozicija, 

način uveza, odnos teksta i slike, stil fotografija ili ilustracije. Također treba odabrati 

tehnike tiska, izbor najekonomičnije varijante reda papira, vrstu uveza i doradu. Organski, 

knjiga se sastoji od knjižnog bloka i knjižnih korica. Često se vanjskom izgledu korica 

dodatno posvećuje  pažnja, jer u najviše slučajeva omot predstavlja i prodaje knjigu. [6] 

 

Testiranje 

Faza testiranja provjerava odgovara li proizvod prethodno zadanim zahtjevima i 

specifikacijama dizajna te jeli, u svom realiziranom obliku, prihvaćen od strane ciljne 
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skupine. U slučaju knjige kao grafičkog proizvoda, testiranje se obično fokusira na njenu 

izvedbu u stvarnom svijetu, odnosno reakciju stvarnih korisnika nakon objave knjige. [6] 

 

2.4.1. Stolno izdavaštvo 

Stolno izdavaštvo (Desktop publishing) ili popularno kraticom DTP, predstavlja proces 

korištenja računala te posebnog računalnog alata za stvaranje i pripremu dokumenta koji u 

svojem dizajnu kombinira tekst i grafičke elemente. Tako su različiti računalni softveri 

omogućili jednostavnu interakciju slike i teksta te mu olakšali slaganje i prelamanje. 

Najpoznatiji softver za prijelom knjige je Adobe Indesign.  

 

2.4.2. Adobe Indesign 

InDesign je program specijaliziran za naprednu manipulaciju tekstom, kao i njegovu 

integraciju sa umetnutim elementima rasterske i vektorske grafike. Također je 

najpopularniji alat za višestranični prijelom jer nudi najveću kontrolu nad dizajnom, 

izgledom i tipografijom.  

Podržavajući srodne programe u Adobovom paketu (Photoshop, Illustrator, PDF Reader) 

ovaj alat pruža jednostavan pristup funkcijama kao što su: uređivanje rukopisa, priprema 

ilustracija, odabir izgleda stranice, vrste i veličine slova, odabir boje, izrađivanje uzoraka 

stranica i još puno toga. Neke mogućnosti, primjerice, stvaranje prozirnih efekata, stvaranje 

sjena, omekšanih rubova, stapanje elemenata, optičko poravnavanje margina omogućuju 

grafičkim dizajnerima kreativno oblikovanje knjige.  

 

2.5. Fotografija kao ilustracija 

U svakodnevnom životu, čovjek se najviše oslanja na vizualne podražaje. Fotografija kao 

glavni nositelj vizualne poruke predstavlja medij koji će ovjekovječiti trenutak u stvarnom 

prostoru. Zato nije čudno kad se kaže „Fotografija vrijedi tisuću riječi“. [7] 

Ova grana umjetnosti je, u svojoj kratkoj povijesti, pronašla velik broj sljedbenika. Glavni 

razlog je taj što fotografija pruža mogućnost zaustavljanja trenutka, ona bilježi konkretni 
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motiv i dosljedna je u prikazu; fotografske snimke su istinite jer objektiv ne može lagati,  

poruka se prenosi nezavisno o jeziku. U tom smislu, ozbiljni fotografi će svojom 

fotografijom uvijek htjeti nešto poručiti.  

Fotografija kao poruka može stajati samostalno no češće je dodatna informacija nekom 

tekstu, grafičkom elementu i slično. U svakodnevnom životu se najviše susreće u obliku 

novinske, modne i reklamne fotografije. [8] 

 

2.5.1. Novinska fotografija 

Novinska fotografija ostvaruje svoju ulogu kao dokument koji svjedoči o trenutku, o kulturi, 

o nekom događaju; ona je komunikacijsko sredstvo kojem se vjeruje. Ubrzo nakon početka 

reprodukcije fotografije na novinskom papiru, ova vrsta ilustracije postaje glavni vizualni 

instrument  koji nadopunjuje i prati određeni novinski članak. Ona uvodi u sadržaj, opisuje 

tekst te nagovara čitatelja da ga prouči. Može se zaključiti da je fotografija neverbalni jezik 

novinarstva jer se najbolje i najlakše razumije. Susreće se u svim oblicima tiskovina, od 

običnih novinskih izdanja do magazina, časopisa i slično. Inače, fotonovinarstvo je najviše 

zaslužno za razvoj digitalne fotografije jer su digitalni podaci fotoreporterima omogućili 

ubrzan proces između snimanja i dostave u redakciju (Slika 3).  

 

2.5.2. Modna fotografija 

Modna fotografija je medij vizualne komunikacije unutar domene primijenjene fotografije. 

U ovoj se disciplini tretira kao oruđe u istraživanju i interpretiranju modne kulture - 

fotografija prikazuje konkretne odjevne predmete, nakit, određeni modni pravac te stil 

oblačenja. U svojoj kratkoj povijesti, ova je grana fotografije zaintrigirala mnoge kreativne 

fotografe, bilo u zatvorenom studijskom prostoru ili u prirodnom okruženju (Slika 3). 

 

2.5.3. Reklamna fotografija 

U okviru semantičke analize reklamnu fotografiju je moguće promatrati kao medij vizualne 

komunikacije kojim se nagovara potencijalnog kupca da kupi, konzumira ili identificira 
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postojeći proizvod, uslugu ili tvrtku. Reklamni prostor se proširuje svakodnevno pa je nekad 

teško naići na mjesto gdje ne iskače neka fotografija ukomponirana s pripadajućim 

simbolom tvrtke. Reklamna fotografija koristi različite pristupe no cilj je uvijek isti - 

reakcija ciljane publike (Slika 3). 

      

 

 

Slika 3 Novinska, modna i reklamna fotografija 
http://www.ivica.kostelic.hr/fotogalerija/20030217233045Vecernji_list3_17.02.2003.jpg 

http://images4.fanpop.com/image/photos/17900000/Fashion-Magazine-taylor-swift-17904910-853-561.jpg 
http://www.photodays-rovinj.com/assets/finalisti2012/primjenjena/11f705b9_t-ht-tmoze-2.jpg 

http://www.ivica.kostelic.hr/fotogalerija/20030217233045Vecernji_list3_17.02.2003.jpg�
http://images4.fanpop.com/image/photos/17900000/Fashion-Magazine-taylor-swift-17904910-853-561.jpg�
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3. EKSPERIMENTALNI DIO 

U eksperimentalnom dijelu diplomskog rada biti će prikazan proces izrade stvarnog 

proizvoda - zbirke poezije „Nešto kao…sjećanja“. Prethodno, u teorijskom dijelu, prikazane 

su osnovne faze oblikovanja grafičkog proizvoda. Slijedom njihovih kriterija, sistematski će 

biti objašnjene aktivnosti pri dizajniranju dotične knjige, počevši od istraživanja, odabira 

fotografija, konkretnih funkcija u računalnim softverima pa sve do konačne realizacije 

knjige. 

Zbirka je autorsko djelo, kategorizirano od strane Nacionalne i Univerzitetske biblioteke 

Bosne i Hercegovine. Nakladnik je Hrvatsko kulturno društvo „Napredak“ a knjiga je tiskana 

u 500 primjeraka. 

 

3.1.  Zahtjevi prije početka oblikovanja zbirke 

Prvi pristup prije dizajniranja zbirke poezije je upoznavanje sa sadržajem rukopisa. Osim 

brzog pogleda na sadržaj i čitanja pjesama, glavne smjernice dizajna su izašle iz recenzije: 

„Čitate li zbirku „Nešto kao sjećanja“ sasvim je jasno da je Davor Hrstić pjesnik sjećanja, pejzaža i 

izgubljenih ljubavi što spavaju u njegovom kamenjaru, utisnute u povijest njegova života. … Njegovo 

pitomo pjesništvo živi u u likovima iz njegovog rodnog sela, njegovi pjesnički sugovornici rade, oru, 

piju, vesele se. … Njegove pjesničke slike su jasne i oštre… Hrstić je pjesnik sela i grada koji im pristupa 

jednostavno i stilom i jezikom, a opet u vama budi najdublji emocionalni doživljaj i prije nego što 

zatvorite korice već ste u vlaku zajedno s pjesnikom“ prof. Jelena Vujčić 

Iz navedenog teksta se da jasno zaključiti da fotografije, koje će ilustrirati zbirku, trebaju 

sadržavati intersubjektivnost kako bi naglasile dijaloški i komunikacijski karakter prema 

temi pjesme. Fotografije će biti umjetničke jer moraju „zračiti“ i poslati poruku čitatelju, a 

upravo je komunikacija ono što izdvaja ozbiljnu fotografiju od amaterske. 

Sam autor iznio je i neke vlastite sugestije. On želi da broj fotografija odgovara broju 

pjesama. Dakle, uz svaku pjesmu stoji popratna fotografija koja će svojim motivom ili 

ugođajem obogatiti pjesmu i pokloniti joj dodatni podražaj. Osim samih ilustracija, 

predložio je kvadratni format zbirke. Također je napomenuo da su materijalna sredstva 

ograničena te da se u tom smislu pokuša dizajnirati ekskluzivno izdanje ali sa što većom 

uštedom u procesu tiska i dorade. 
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3.2. Dizajn 

Faza dizajna je faza u kojoj se knjiga počinje oblikovati u skladu s prethodno postavljenim 

zahtjevima. Tada nastaje početni koncept zbirke na tragu prvih reakcija na sadržaj poezije. 

U tom kreativnom procesu, prije otvaranja dokumenata i materijala u Photoshopu ili 

Indesignu, se grade skice na kojima će se temeljiti konačan dizajn. One se predstavljaju 

naručiocu (u ovom slučaju nakladniku) na suglasnost za daljnje oblikovanje. Po njegovim 

zahtjevima, odlučeno je da će fotografije biti umjetničke crno bijele jer svojom sjetom i 

izražajem odgovaraju naravi pjesama, ali će se na taj način i uštedjeti na tisku - fotografija 

se tiska iz samo jedne procesne boje (crne - karbon). 

 

3.2.1. Odabir fotografija 

Zbirka poezije „Nešto kao…sjećanja“ je ilustrirana crno bijelim umjetničkim fotografijama. 

Odabir fotografija nije jednostavan zadatak; potrebno je pročitati svaku od pjesama te izvući 

neke od glavnih motiva koji se trebaju preklapati s motivom fotografije. One sadrže jasno 

iskazanu selektivnost prizora te čitatelja navode da osjeća prisutnost autora. Određene 

pjesme nisu imale tematski pripadajuću sliku iz vlastite mape radova pa su se trebale  

naknadno snimiti. Također, za pjesme s temom Sarajeva, autor je zahtijevao prepoznatljive 

kadrove iz dotičnog grada pa su fotografije preuzete iz tuđe kolekcije (Slika 16). 

Crno bijele fotografije su izabrane na način da generiraju slične emocije kod čitatelja kao i 

pjesma koja stoji uz nju. Izborom motiva i načinom prikazivanja crno bijela fotografija 

podjednako izražava svoju umjetničku, estetsku ali i tematsku vrijednost pjesme.  

 

3.2.2. Estetski zahtjevi crno bijele fotografije 

Kaže se da fotografija treba pokazivati ono što je iza kamere, a ne ispred nje. Prvo se rađa u 

glavi fotografa pa tek onda nastaje na fotoosjetljivom materijalu. Premda digitalna 

tehnologija ide u pravcu razvijanja kolor fotografije, jako puno fotografa ali i publike još 

uvijek „pada“ na crno bijelu fotografiju. Laički se može zaključiti da je lakše raditi tom 

tehnikom jer ne treba paziti na boje, no kvalitetnu crno bijelu fotografiju prilično je teško 

snimiti. Fotografi kojima je ona favorit trebaju savladati percepciju svijetla na način da se 
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njihova mentalna slika svijeta odražava u sivim tonovima. Potrebna je i nadarenost u 

opažanju formi i oblika pod različitim kutovima svijetla. Zato je važno napomenuti da su sve 

fotografije u zbirci nastale u prirodnom okruženju bez umjetne rasvjete, odnosno pomoću  

sunčevog osvjetljenja. 

Jedinstveni recept za snimak crno bijele fotografije koja posjeduje sve odlike i elemente 

umjetničkog djela teško je složiti. Postoje određena estetska načela o pravilnom 

fotografiranju (primjerice zlatni rez, pravilo trećina…) no poštivanje tih pravila ne garantira 

vrhunsku fotografiju. Uz to je potrebna kreativnost, ideja, duh, znatiželja, inovativnost  

kako bi fotografija postala prozorom fotografske misli. Vođene tim smjernicama, fotografije 

iz zbirke su nastale igrom različitih načina snimanja od kojih treba napomenuti  

najpopularnije: 

- tehnika niskih tonova (low-key) - podrazumijeva prevladavanje tamnih tonova (Slika 4a) 

- tehnika krupnog plana (close-up) - naglašava najzanimljivije dijelove (Slika 4b) 

- duga ekspozicija - produženo vrijeme snimanja kako bi se dobio zamućeni motiv s dojmom 

pokreta (Slika 4c) 

- zamućenje prvog plana - snimanje motiva na način da se objekti u prvom planu postave 

blizu fotografskog objektiva u svrhu pojačavanja perspektive (Slika 4d) 

- namjerno pojačavanje ISO osjetljivosti - za dojam šuma analogne fotografije (Slika 4e) 

- namjerno stvaranje lens flair - odbljesak (Slika 4f) 
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a)     b)  

c)     d)  

 e)     f)  

Slika 4 Kreativni načini snimanja 
a)Fotografija s prevladavajućim tamnim tonovima 

b)Fotografija s motivom snimljenim u krupnom planu 
c)Fotografija snimljena u dugoj ekspoziciji  

d)Fotografija sa zamućenim prednjim objektima  
e)Fotografija s namjerno izazvanim šumom 

f)Fotografija s efektom lens flair 
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3.2.3. Odabir prijeloma knjige 

Kvadratnim formatom je naglašena ekskluzivnost knjige te će se odabirom jednostavnog 

prijeloma još dodatno pojačati dojam skupoće. Kako bi se ostvario ritam, svakoj pjesmi je 

dodijeljena prikladna crno bijela fotografija, nekad na lijevoj a nekad na desnoj strani. 

Tipografija mora biti serifna zbog čitljivosti, no dodatni razlog je sam izgled serifnog fonta 

koji odražava tradicionalnost i standard pisanja poetskog djela. Uz takvu tipografiju je 

odabran i poseban ukrasni font za naslove. 

 

3.2.4. Istraživanje postojećih rješenja 

U kreativnoj fazi dizajna knjige, skicama (na kojima će nastati finalno rješenje) obično 

prethodi pažljivo istraživanje postojećih rješenja. U sljedećim primjerima predstavljeni su 

konkretni grafički proizvodi koji, poput zbirke, spajaju fotografiju i literarni sadržaj. Cilj 

ovog istraživanja je dobivanje jasnije slike o mogućim verzijama kombinacije slike i teksta. 

 

Poezija 

"Poezija – časopis pjesničke prakse" je jedini časopis u Hrvatskoj koji prati aktualnu domaću 

pjesničku scenu. Osim objavljivanja tekstova poznatih i novih imena hrvatskih pjesnika, 

kritičara i teoretičara, časopis je obogaćen crno-bijelim fotografijama i ilustracijama (Slika 

5). Upravo zbog tog razloga, „Poezija” se smatra izvrsnim primjerom simbioze fotografije i 

poezije na način da spaja najveće domaće pjesničke talente s mladim fotografima. Oni 

svojim fotografijama prate objavljene pjesme te im poklanjaju dodatni značaj. Osim 

popratne fotografije koja se nalazi pokraj pjesme, najsvjetliji odnosno najtamniji dijelovi 

fotografije na određenim stranicama su postavljeni kao pozadine na kojoj se tiska tekst. 

Zbog toga je časopis pun fotografija koje su kontrastne. Na nekim stranicama se fotografija 

pruža cijelim formatom dok je na drugim izrezana u obliku traka koje krase bjelinu stranice.  

Uredništvo surađuje s mladim hrvatskim fotografima među kojima su i studenti Grafičkog 

fakulteta. Tako su svoje fotografije u ovom časopisu objavili studenti Žana Soče, Petra 

Slobodnjak, Neven Udovičić i Jelena Balić. 
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Slika 5 Časopis „Poezija” 

 

Izdanja u biblioteci Bibliofil 

Bublioteka Bibliofil Global d.o.o. je antikvarijat-knjižara specijalizirana za vrijedna, rijetka, 

zanimljiva i out of print izdanja. Među mnoštvom knjiga koje se ističu svojim atraktivnim 

grafičkim oblikovanjem, postoje i zbirke poezije obogaćene kvalitetnim fotografijama. 

Najpoznatija među njima je poetsko-fotografska monografija „Sami u toj šumi” pjesnika 

Drage Glamuzine i fotografa Stanka Abadžića (Slika 6a). Pedeset Glamuzininih pjesama 

popraćene su jednakim brojem crno bijelih fotografija. Stihovi pjesama ukrašeni su ženskim 

aktovima u kojima se slavi erotika i ljepota nagog tijela. Riječ je o fotografijama koje ne 

prikazuju samo golo tijelo već svojom ekspresijom omogućuju jači doživljaj poetskog 

sadržaja. One naslućuju najvažnije emocije opisane u pjesmama: strast, zanesenost, čežnja, 

strah. Knjiga je tiskana u manjoj nakladi, tisak je dvobojni te je korišten visoko kvalitetni 

papir. Može se reći da se radi o ekskluzivnom i rijetkom izdanju. 
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Knjiga „Dvojnost” 

Knjiga "Dvojnost" predstavlja fotografije sarajevskog umjetnika Erola Čolakovića Šehića i 

poeziju pjesnikinje Dare Sekulić (Slika 6b). Sami naziv knjige ukazuje na dijalog fotografskog 

umijeća i pisane riječi te je zbog tog razloga uvrštena kao dobar primjer u istraživačkom 

dijelu rada. No, za razliku od ostalih primjera, u ovoj knjizi fotografija ne prati tekst već ona 

ima jednak značaj kao i sama pjesma. Riječ je o fotografijama čija je osnovna tema žensko 

tijelo predstavljeno u raznim situacijama i pozama. Na promociji knjige otvorena je i izložba 

fotografija, što je česta pojava bez obzira jesu te slike objavljene u knjizi ili nisu.  

 

Projekt akademskog slikara i scenogrfa Saše Šekoranje 

Akademski slikar i scenograf Saša Šekoranja je iskoristio stare fotografije Zvonimira Goloba 

te ih oživio s vlastitim rukopisom. Na sajmu antikviteta naišao je na fotografije 

spomenutoga autora te mu se probudila ideja da na poleđini tih fotografija ispiše odabrane 

pjesme (Slika 6c). Izložba se održala u galeriji Velvet, a koncept izložbe je oblikovan na 

način da fotografije nisu fiksirane na zid već vise sa stropa. Tako posjetitelji s prednje strane 

uživaju u fotografiji a na poleđini mogu čitati poeziju. Upravo je zbog toga izložba postala 

jedinstven i neponovljiv umjetnički doživljaj. Fotografije su rađene u crno bijeloj i sepia 

tehnici. Kao i na prethodnim primjerima, glavni motiv je žena. 

 

CD omoti 

Glazbeni CD omot je idealan primjer multimedijskog sadržaja koji se bazira na dijalogu 

između zvuka, muzike, poezije, teksta, grafike i fotografije (Slika 7). Zbog toga, grafičko 

oblikovanje CD omota postaje važan dio prezentacije autora, glazbenika ili benda. Postoji 

bezbroj primjera gdje je fotografija postavljena kao glavni vizual na coveru albuma, ali valja 

spomenuti one omote koji na svojim dodatnim stranicama sadrže fotografije uz koje su 

najčešće smješteni tekstovi pjesama. Fotografije su često kvadratnog oblika i svojim bojama, 

motivima ili temom odgovaraju konceptu glazbenog albuma. 
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a)   b  
 

c)  
 

Slika 6 Različiti primjeri sinteze fotografije i poezije 
a)Knjiga „Sami u toj šumi” pjesnika Drage Glamuzine i fotografa Stanka Abadžića 

http://www.tportal.hr/ResourceManager/GetImage.aspx?imgId=230372&fmtId=24 
b)Knjiga "Dvojnost" 

http://www.sutra.ba/slike/kultura/dvojnost_97.jpg 
c) Projekt akademskog slikara i scenogrfa Saše Šekoranje 

http://www.vecernji.hr/slika-640x348/vijesti/pjesme-fotografije-zvonimira-goloba-velvetu-slika-196678 

 

 

Slika 7 Primjer cd omota 
http://behance.vo.llnwd.net/profiles22/251137/projects/3986589/7e2548c7c111f959534dc97586d425e1.JPG 

  

http://www.tportal.hr/ResourceManager/GetImage.aspx?imgId=230372&fmtId=24�
http://www.sutra.ba/slike/kultura/dvojnost_97.jpg�
http://www.vecernji.hr/slika-640x348/vijesti/pjesme-fotografije-zvonimira-goloba-velvetu-slika-196678�
http://behance.vo.llnwd.net/profiles22/251137/projects/3986589/7e2548c7c111f959534dc97586d425e1.JPG�
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3.3. Razvoj konačnog rješenja knjige 

U razvojnom ciklusu, potrebno je odrediti parametre oblikovanja zbirke poput formata, 

tipografije, kompozicije teksta i slike, obrade fotografije i tako dalje. Također treba 

pripremiti dokument za tisak te odabrati vrstu papira i način uveza. U ovoj fazi biti će 

prikazani konkretni primjeri i situacije u Photoshopu počevši od obrade fotografije do 

njezina pohranjivanja kao i radnje u Indesignu poput umetanja fotografije, prijeloma teksta 

i pripremanja virtualne zbirke za reprodukciju. [6] 

 

3.3.1. Konvertiranje RAW formata 

Fotografije objavljene u zbirci, originalno su snimljene u RAW formatu. Takozvani digitalni 

negativ dopušta najveću fleksibilnost i najviše prostora za mijenjanje slike, istovremeno 

čuvajući kvalitetu. No, da bi se slika pravilno prikazala na nekom računalu potreban je 

odgovarajući pomoćni softver, odnosno RAW konverter (Slika 8). On dolazi već 

implementiran u nekom od programa za obradu i pregledavanje digitalnih fotografija, u 

ovom slučaju kao standardni plug-in uz Adobe Photoshop CS4.  

Za potrebe diplomskog rada korišten je fotoaparat marke Nikon D60 koji posjeduje vlastitu 

ekstenziju za RAW format, a to je NEF. Da bi se snimila fotografija u ovom zapisu potrebno je 

prethodno podesiti postavke u kameri. Snimljena slika NEF formata se prebaci na računalo i 

otvori pomoću Photoshopa, ali prije njega se automatski uključuje RAW konverter. 

   

Slika 8 RAW konverter 

 

U RAW konverteru možemo lako kontrolirati vrijednosti osnovnih parametara i korigirati  

tehničke nedostatke originalnog snimka. Ovaj format ne zaključava postupak nakon 
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okidanja aparatom pa tako u post-procesiranju  nudi podešavanje osnovnog seta postavki 

(Slika 8): 

• Bijeli balans - podešavanje balansa bijele boje 

            white balance  //  temperature  //  tint 

• Ekspozicija - poboljšana fleksibilnost u ispravljanju grešaka u ekspoziciji 

            exposure  //   fill-light //  recovery 

• Osnovna podešavanja - poboljšana kontrola u odnosu na druge formate datoteka 

            brightness  //  contrast  //  levels  //  curves 

• Boje - moguće posvijetliti ili prigušiti boje, ali i potpuno zamijeniti jednu boju 

drugom  

            hue //  saturation  //  vibrance 

• Detalji i oštrina - poboljšana kontrola oštrine u odnosu na druge formate datoteka            

sharpening  //  details  //  clarity 

• Kontrola šuma - redukcija šuma 

            noise reduction 

Osim svih postavki koje su podešene na aparatu, RAW konverter može korigirati čak i 

ekspoziciju. To znači da se fotografija naknadno može posvijetliti/potamniti ako je krivo 

određena ekspozicija; mogu se izvući detalji u sjenama ili spasiti djelomično preeksponirane 

dijelove fotografije. Boje se mogu podesiti preko balansa bijele boje, tona i zasićenosti boje. 

Također se može povećati ili smanjiti oštrina, otkloniti geometrijske deformacije i slično. 

Osim ovih temeljnih, većina konvertera ponuditi će još mnoštvo dodatnih opcija. 

Ako se želi da RAW konvekter sam analizira fotografiju i promijeni postavke u njemu 

pravilnim vrijednostima, onda treba kliknuti na Auto. Kada je završeno podešavanje u 

konverteru, nude se četiri opcije: 

• Apply - primijeni podešene postavke na datoteku 

• Open - otvori podešenu sliku u nekoj drugoj aplikaciji 

• Save - sačuvaj podešenu sliku u nekom drugom formatu (JPEG, PSD, TIFF ili DNG). 

• Done - završi proces u RAW konverteru 
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Za pravilno umetanje fotografije u daljnjim procesima, potrebno ju je spremiti u standardni 

format za pohranjivanje rasterske grafike namijenjene za tisak - TIFF format (Slika 8). 

 

3.3.2. Obrada fotografije u Photoshopu 

U daljnjem razvojnom procesu, spremljenu TIFF slikovnu datoteku treba otvoriti u 

Photoshopu, pretvoriti iz kolor u crno bijelu verziju i obraditi je po standardima stolnog 

izdavaštva.  Potrebno ju je pripremiti kao predložak za importiranje u Indesign u kojem će 

se vršiti prijelom teksta. Pri obradi takvog predloška, postoji zahtjev za drugim prostorom 

boja od prostora u kojem je fotografija snimljena, te veća izlazna rezolucija. Fotografiju 

treba prvo otvoriti u navedenom programu. 

File > Open 

Sljedeća akcija u Photoshopu je mijenjanje dimenzija fotografije. Budući da je odabran 

kvadratni format zbirke i odlučeno da se slika pruža na cijelu plohu stranice, fotografija 

mora mijenjati svoje dimenzije, točnije, mora se rezati u zadanim dimenzijama 

20,6cmx20,6cm. U lijevoj alatnoj traci selektira se opcija za rezanje fotografije te se u gornjoj 

zadaju dimenzije i razolucija od 300dpi (Slika 9). Vodeći računa o estetskim i 

kompozicijskim načelima i o važnosti motiva, pri rezanju se mora paziti koji dio od 

pravokutne slike ostaviti a koji izbaciti (Slika 10). 

 

 

Slika 9 Rezanje fotografije po zadanim dimenzijama 
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Slika 10 Rezanje fotografije prema estetskim i kompozicijskim načelima  

 

3.3.3. Pretvorba kolor fotografije u crno bijelu fotografiju 

Od početka pojave digitalne fotografije, digitalni fotoaparati automatski snimaju u kolor 

tehnici. No ipak, danas većina njih sadrži mogućnost snimanja i crno bijele fotografije. 

Postavlja se pitanje jeli pravilno iskoristiti mogućnost fotoaparata i snimati takvu 

fotografiju na licu mjesta ili će pretvorbu iz kolora u crno-bijelo uspješnije odraditi 

Photoshop. Profesionalniji pristup je zanemarivanje opcije direktnog snimanja crno bijelih 

fotografija koju ima većina digitalnih fotoaparata. Puno bolju fotografiju možemo dobiti 

obradom u Photoshopu, ali i ta pretvorba posjeduje vlastitu problematiku. Slika 11 jasno 

prikazuje različitost pretvorba. Kvadrat s četiri različite boje, ali iste svjetline posjeduje više 

crno bijelih riješenja ovisno o tipu pretvotbe. Zato razlikujemo:  

• Pretvorbu prema svjetlini boja i 

• Pretvorbu promjenom boja na fotografiji. 

Cilj ovih pretvorbi je fotografija s raznolikim vrijednostima sivih tonova s izraženim 

kontrastom i dojmom dinamike kako bi snimljeni prizor bio što izraženiji. 

Za crno bijele fotografije korištene u zbirci, odabran je jednobojni tisak pa u računalnom 

programu sliku treba pretvoriti kao zapis crne boje samo u jednom kanalu (grayscale) i tako 

izbjeći korištenje sve četiri boje (CMYK). Osim fotografija, zbirka je obogaćena s par crteža, 

koje nisu tema ovog diplomskog rada, ali je važno napomenuti da se u tehnološkom smislu 

ponašaju identično kao fotografije, jer su digitalizirane pomoću fotoaparata i na taj način 

prolaze iste procese obrade. 
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Slika 11 Različita crno bijela rješenja ovisno o tipu pretvorbe 

 

3.3.3.1. Pretvorba prema svjetlini boja 

U crno bijeloj digitalnoj fotografiji mogu se postići razni dojmovi i vrste svijetlih i tamnih 

tonova, a njih se metodom pretvorbe prema svjetlini boja može obraditi na više načina. U 

sljedećim primjerima je prikazano kako svaka metoda vrši pretvorbu prema drukčijim 

algoritmima. U praktičnom dijelu obrade fotografija za zbirku pozije „Nešto kao… sjećanja“ 

najviše je korištena Lab metoda. 

 

Lab pretvorba 

Ova pretvorba koristi informacije iz Lab kanala boja (lightness channel) tako da prevodi boje u 

sive tonove procjenom njihove svjetline slično načinu u kojem crno bijeli film reagira na 

boje iz stvarnosti. Lab metoda je najviše korištena pri obradi fotografija za zbirku poezije, 

jer se s njom daju izvući odlične crno bijele varijante.  

Na radnoj površini Photoshopa se prvo mora osigurati vidljivost panela Channels.  

Window > Channels.              

Pretvorba počinje definiranjem RGB fotografije u Lab prostor boja (Slika 12): 

Image > Mode > Lab Color. (1)  

 

http://www.fotografija.hr/crnobijela-fotografija/740/#lab�
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Slika 12 Definiranje fotografije u Lab prostor boja 

Otvaranjem panela vidljiva su tri kanala; umjesto crvenog, zelenog i plavog kanala (RGB) 

stoje kanali Lightness, a i b (Slika 13). Zatim se slika treba prebaciti u grayscale da sadrži 

samo jedan gray kanal. Pretvorba je moguća klikom na kanal Lightness (2), a zatim na:  

Image > Mode > Grayscale.            (3) 

 

 
Slika 13 Stvaranje grayscale fotografije 
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U tom trenutku pojaviti će se prozor s porukom “Discard other Channels?” preko kojeg se 

klikom na OK brišu kanali boja a i b jer više nisu potrebni. 

Dobila se crno bijela fotografija koja se dalje može dotjerivati različitim efektima i 

upotrebom filtera. Tako su fotografije, za potrebe zbirke, korigirane alatom Curves i alatom 

Levels (Slika 14):  

Image > Adjustments > Curves 

Image > Adjustments > Levels       

Krivulje definiraju graf koji prikazuje odnose tonova. Mijenjanjem izgleda krivulje grafa 

moguća je korekcija tonova a time i pojačanje kontrasta potrebnog za dinamiku crno bijele 

slike. Za potrebe korekcije, koristi se i alat Levels koji je manje profesionalan od krivulja, ali 

preko njega se lakše podešava crna, bijela i siva točka. 

             

Slika 14 Korigiranje fotografije kroz alate Curves i Levels 

 

 

Slika 15 History preglednik 
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Krajnji rezultat je fotografija naglašenog kontrasta s optimiziranim dinamičkim rasponom 

tonova. Također je važno napomenuti da je na početku obrade, pretvorbu pametno obavljati 

na kopiji sloja (layer) fotografije kako bi početno stanje slike ostalo netaknuto, odnosno 

osigurati je u slučaju pogreške. Na slici 15 prikazan je history preglednik, koji pokazuje 

najčešće aktivnosti pri obradi fotografija za zbirku pjesama. 

Za fotografije koje će se tiskati, dobro je napraviti probni otisak kako bi se dodatno 

korigirale i prepravile. Testiranja uvelike pomažu jer se mogu uvidjeti pogreške u prikazu 

svijetlih tonova. Naime, zbog različitih definiranja vrijednosti na papiru (od 1 do 100) i na 

ekranu (od 1 do 256), tonovi u svijetlim dijelovima doimaju se više kontrastno na ekranu 

računala nego na otisnutom papiru. 

Osim obrade fotografije pomoću krivulja i ostalih podešavanja, na seriji fotografija uz 

pjesme tematikom vezane uz Sarajevo, napravljen je proces interpolacije. Razlog je taj što 

fotografije nisu preuzete iz vlastite mape, već su snimljene mobitelom od strane drugog 

fotografa. Zbog karakterističnog mjesta na kojem su snimljene, autor zbirke je inzistirao na 

objavi tih fotografija, premda svojom kvalitetom nisu bile spremne za tisak. Osim povećanja, 

i namještanja parametara za pravilnu reprodukciju, različitim efektima u Photoshopu 

mijenjan je estetski vizual fotografije. Aktivacijom filtera Film grain ostvaren  je umjetnički 

dojam zrna crno bijele analogne fotografije (Slika 16). 

 

Slika 16 Obrada fotografije interpolacijom i dodavanjem efekta Film grain 
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Grayscale 

Jedna od najbržih ali i najlošijih metoda pretvorbe je izravna promjena sive skale, odnosno 

obična grayscale metoda. Izvodi se na način da se smanji zasićenost boja na slici, dok ukupne 

vrijednosti svjetline ostaju nepromijenjene. Pretvorba je jednostavna, no rezultira plošnom 

fotografijom loše distribucije tonova. Kolorna fotografija se pretvara na način da se u 

Photoshopu odabere (Slika 17): 

Image > Mode > Grayscale. 

Program pritom pita mogu li biti izbrisane vrijednosti boja “Discard color information?“, a 

nakon pritiska OK, dobivena je osrednje dobra crno bijela fotografija.  

 

Slika17. Grayscale pretvorba 

 

Desaturate 

Još jedna u nizu loših pretvorbi je izravna desaturacija boja. Metoda nije pogodna jer daje 

plošnu i beživotnu sliku (Slika 18).  

Image > Adjustments > Desaturate. 

 

Slika 18 Desaturate pretvorba 
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Gradient Map 

Gradient map je je jednostavna i brza metoda dobrih rezultata jer generira kontrastne tonove 

i prema različitim bojama i prema svjetlini (Slika 19). Također je pogodna i za duoton 

fotografije. Sliku ostavlja u RGB modelu te ju je za potrebe jednobojnog tiska potrebno 

pretvoriti u grayscale. 

Image > Adjustments> Gradient Map. 

 

Slika 19 Gradient Map pretvorba 

 

3.3.3.2. Pretvorba promjenom boja 

Pretvorba promjenom boja može se obaviti na dva načina: pomoću alata Channel mixer i 

upotrebom opcije Black & white. 

 

Channel mixer 

Jednostavna pretvorba kolor fotografije u crno bijelu preko Channel mixer-a, daje dobre 

rezultate te je u sklopu ovog rada korištena za obradu nekoliko fotografija. Ova opcija nudi 

cijeli niz podešavanja jer omogućuje posuđivanje tonskih informacija, pojačavanje i 

oslabljivanje pojedinih boja preko kanala. Pomicanjem klizača lijevo i desno moguće je 

svaku pojedinu boju predstaviti raznim nijansama i intenzitetima u neograničenom broju 

kombinacija. Fotografije iz zbirke obrađivane ovom metodom, uglavnom imaju određene 

boje koje se u crno bijeloj varijanti trebaju naglasiti odgovarajućim sivim tonom. Tako je,  

http://www.fotografija.hr/kanali-channels-1dio/734#mikser�
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primjerice, panoramska fotografija uz pjesmu „Oblaci“, zahtijevala izražajan prikaz neba i u 

crno bijeloj varijanti. 

Pretvorba počinje odlaskom u izbornik Channel Mixer gdje će se otvoriti novi prozorčić. U 

donjem lijevom kutu se označi opcija Monochrome i bez dodatnih podešavanja odmah se 

dobiva crno bijeli prikaz.  

Image > Adjustments > Channel Mixer 

Obrada se nastavlja mijenjanjem parametara boja pomoću klizača. Pomicanjem klizača 

plave boje na desno, a ostalih klizača na lijevo postignut je dramatičan izgled neba i na crno 

bijeloj verziji dotične fotografije (Slika 20). Nakon obrade slika je pretvorena u grayscale 

kako bi bila spremna za jednobojni ofsetni tisak. 

 

Slika 20 Channel mixer 

 

Black & white  

Uporabom alata Black & white, slično kao i u pretvorbi preko Channel mixera, moguće je 

mijenjati vrijednosti sivih tonova povlačenjem klizača lijevo/desno za pojedine grupe:  

Window > Adjustments > Black & White. 

Ova metoda pruža detaljnu konverziju obojenih slika u crno bijele varijante jer se precizno 

može utjecati na tonske vrijednosti pojedine nijanse boje: crvene,  žute,  zelene,  cyan,  

plave i magente. Black & white opcija također nudi i nekoliko filtera iz padajućeg menu-a, kao 
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i mogućnost kreiranja toniranih fotografija (Slika 21). I u ovom modelu pretvorbe, za 

potrebe tiska je potrebno fotografiju prebaciti u grayscale prikaz.  

 

Slika 21 Black&White 

 

3.3.4. Pohranjivanje fotografije 

Nakon obrade fotografija slijedi pohranjivanje slikovnih datoteka u format čitljiv 

tiskarskom stroju. Prije spremanja, pametno je provjeriti li fotografija u grayscale modelu, a 

to je najlakše napraviti prelaženjem preko slike s eyedroper tool-om. Ako je slika pravilno 

definirana, u info paleti će se prikazivati vrijednosti crne boje u postotcima, odnosno pisati 

će, primjerice K:90%, K:60%. 

U teoretskom dijelu ovog diplomskog rada, objašnjeni su karakteristični formati te je 

najbolja opcija za sljedeći korak u pripremi knjige (import u program Indesign), odabir TIFF 

slikovnog formata. Pohranjivanje se odvija preko naredbe: 

File > Save as. 

Klikom se otvori prozor u kojem se odabere mjesto pohrane, ime te format slike. U 

padajućem meni-u odaberemo format TIFF. Slijedi odabir opcija, kao što je kompresija, a 

nakon pritiska non (bez kompresije), fotografija je uspješno spremljena i spremna za 

umetanje u program za prijelom teksta (Slika 22). 
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Slika 22 Pohranjivanje TIFF fotografije 

 

3.3.5. Priprema naslovnice 

Naslovnica treba izazvati reakciju, jer korice najčešće prodaju knjigu. Odabrana fotografija 

zato intrigira i izaziva duboke emocije bliske temama pjesama unutar zbirke (Slika 23).  

Format knjige je kvadrantan, no za definiranje dimenzija ovitka knjige potrebno je 

duplicirati dimenzije stranice i dodati 10mm zbog hrbata knjige. Konačne dimenzije 

naslovnice su tako 62mmx26mm. Naslovnica koristi fotografiju u boji, tako da pohranjivanje 

zahtijeva CMYK  prostor boja.  

 

Slika 23 Odabrana fotografija za naslovnicu zbirke 
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3.3.6. Prijelom knjige u Indesignu 

Sljedeći zahtjev u razradi proizvodnog procesa knjige je implementiranje slika u Indesign te 

dizajniranje prijeloma knjige. Kao tehnika tiska izabran je offset, tako da definiranje 

dimenzija neobrezane veličine knjižnog bloka zbirke ovisi o samim dimenzijama tiskovnog 

arka. Potrebno je izraditi proračun odgovarajuće kvadratne dimenzije kako bi što više 

stranica stalo na jedan knjižni arak formata A1. Utvrđeno je da su dimenzije 20cmx20cm 

zajedno s napustom od 3mm sa svake strane zadovoljavajuće dimenzije te je sljedeći korak 

otvaranje dokumenta u Adobovom Indesignu. 

Program pruža maksimalnu kontrolu nad izgledom stranice; u njemu se lako definira 

podjela prostora pomoću margina i stupaca. Razne mogućnosti pri integraciji slike i teksta 

kao i alati za izradu mastera i stilova, čine Indesign korisnim softverom. Master stranice su 

predlošci koji se koriste da se automatski kopiraju ili povežu elementi i pritom ubrza izrada 

više straničnog dokumenta. Stilovi su također definirani predlošci koji se lako mogu 

mijenjati i dodavati nekom tekstu, sadržaju ili grafičkom elementu. 

 

3.3.6.1. Otvaranje dokumenta 

Pri otvaranju Indesign programa, odabirom naredbe iz izbornika  

File > New document 

pokreće se dijaloški prozor gdje se zadaju glavni parametri - broj stranica, dimenzije, širina 

margina i broj kolumni dokumenta i njihov razmak (Slika 24). Broj stranica dokumenta je 

okvirno 100, no taj se broj može mijenjati jednostavnim procesima u Indesignu (Edit – Pages - 

Move/ Insert/ Delete…). Dimenzije od 20,6cmx20,6cm su prethodno zadane. 

 

3.3.6.2. Umetanje fotografije 

Svakoj pjesmi je dodijeljena prikladna crno bijela fotografija, nekad smještena lijevo a nekad 

desno od pjesme. Na nekoliko stranica u zbirci, fotografija se prostire preko dvije stranice. 

One stvaraju osjećaj skupoće, prijelaza u neki drugi dio knjige, odvajaju pjesme prema 

tematici te tako pridonose ukupnoj estetici i percepciji sadržaja pjesama. Umetanje 
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spremnih TIFF slikovnih datoteka je veoma lako. Preko naredbe Place, slike treba posložiti 

ovisno o rasporedu pjesama (Slika 25). 

File > Place 

 

 

Slika 24 Otvaranje dokumenta u Indesignu 

 

 

Slika 25 Umetanje fotografija u Indesignu 
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3.3.6.3. Prijelom teksta 

Adobe InDesign je program specijaliziran za naprednu manipulaciju tekstom, no za potrebe 

slaganja zbirke pjesama, korišteni su osnovni alati jer je prijelom prilično jednostavan. 

Budući da se radi o pjesmama koje sadržajno zahtijevaju dosta prostora na stranici i ne 

smiju se „gužvati“ međusobno, definiran je centriran prijelom. Svakoj pjesmi je dodijeljena 

jedna stranica te fotografija lijevo ili desno od nje. Da bi se umetnuo tekst u Indesignu, prvo 

se  kreira okvir, zatim se selektira pa tek onda lijepi kopirana pjesma. Ako okvir nije 

dovoljno velik za pjesmu, pojaviti će se mali crveni kvadrat u donjem rubu te upozoriti na 

problem. 

Odabrani font za slaganje pjesama je Gentium - serifni font koji odiše tradicionalnim duhom, 

oštrijim rezovima ali prije svega visokim stupnjem čitljivosti. Odabrani stil za tekstove 

pjesama koristi upravo više rezova Gentiuma, veličine slovnog znaka od 11pt te bojom 100% 

crnom (Slika 26a). 

Dodatni izabrani font je Memoriam. Zbog svog svečanog i ukrasnog karaktera korišten je na 

naslovnici knjige, ali i u naslovima unutar knjige. Također je implementiran u izdvojene 

dijelove teksta na nekim fotografijama, s ciljem da intrigira čitatelja i podigne dojam 

skupoće pri otvaranju i listanju knjige (Slika 26b). 

Pored vizualnog oblikovanja, tekst je, u tehničkom smislu definiran preko jedne boje (radi 

potrebe jednobojnog ofsetnog tiska). Prije spremanja dokumenta, važno je provjeriti jeli sav 

tekst prikazan u 100% crnoj karbon boji ili u 0% ako se radi o tekstu kao negativu na tamnoj 

plohi pripadajuće fotografije. Na kraju slaganja teksta, fontovi se trebaju pretvoriti u 

krivulje, jer se može dogoditi da stroj ne prepozna korišteni font te ga zamijeni nekim 

drugim neodgovarajućim fontom. 

a)       b)  

Slika 26 Odabrani fontovi za zbirku a) Gentium b) Memoriam 
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3.3.7. Priprema dokumenta za tisak  

Nakon što je posložen konačan raspored teksta i pjesama te prijelom zbirke dobio svoj 

finalni izgled, dolazi se do pripreme dokumenta za tisak. Prije spremanja, važno je 

prekontrolirati jesu li zadovoljeni svi parametri za procese reprodukcije. Obavezno treba 

provjeriti: 

• Format stranice - sve stranice, uz svoje stvarne dimenzije trebaju imati 3mm 

napusta, zbog rezanja nakon procesa tiska dok ovitak knjige uz napust treba imati 

dodatnih 10mm po sredini zbog ukupne debljine stranica (hrbat knjige) 

• Fontovi - fontove treba konvertirati u krivulje 

• Prostor boja - osim ovitka zbirke, sve fotografije moraju biti spremljene isključivo u 

grayscale modelu 

• Tekst -  mora biti prikazan preko jedne crne boje, nikako sve 4 boje 

• Napust - vidjeti jesu li sve fotografije ispravno položene, tako da se mogu sa svih 

strana rezati po 3 mm, i korigirati tekst u slučaju da se nalazi manje od 5 mm od ruba 

reznih marki 

• Rezolucija - sve fotografije moraju biti TIFF formati spremljeni u potrebnoj rezoluciji 

za tisak (300 dpi)  

Najpouzdaniji format datoteke za tisak je PDF (Portable document format). Stvoren je za 

prenošenje dokumenata sa jednog računala na drugo, neovisno o kojoj se platformi radi. U 

ovom formatu se šalje zbirka u tiskaru. Eksportiranje PDF formata se vrši kroz niz opcija: 

File > Export 

U padajućem meniju treba izabrati Press Quality, te  kliknuti na opciju All, kako bi se spremile 

sve stranice u dokumentu. S lijeve strane se nalazi opcija Marks and Bleeds, koja definira 

rezne marke i napust. Treba označiti Trim marks, kako bi u PDF-u bile označene rezne linije 

te se izabere opcija da program koristi napust (Use dokument bleed settings) koji je prethodno 

definiran u Indesignu (Slika 27). Nakon klika na opciju Save PDF, dokument je spremljen te 

spreman za slanje na drugo računalo. 
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Slika 27 PDF postavke dokumenta za tisak 
 

3.3.8. Tisak 

Knjiga je tiskana tiskari „Grafotisak“ u Grudama, BiH. Korišteni ofsetni stroj je Heidelberg 

SM 52 x 35 cm, 2 boje, dok je za tisak korica korišten Heilderberg SM 102 x 72 cm, 4 boje. Svi 

instalirani strojevi su modeli najnovije generacije s punim opcijama kao što je automatski 

sustav upravljanja. Što se tiče doradnih procesa, odabran je meki uvez, a lijepljenje stranica 

obavljeno je strojno. 

 

3.4. Testiranje 

Testiranje je faza provjere konačnog otisnutog proizvoda. Nakon dugotrajne pripreme i 

tiskanja, zbirka je dobila svoju izvedbu u stvarnom svijetu. Napokon je moguće proučiti je li 

zbirka svojim sadržajem i vizualnim identitetom dovoljno primamljiva i interesantna knjiga 

ciljanoj grupi (Slika 28). 
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Slika 28 Konačni otisnuti proizvod – zbirka pjesama 
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Pozitivne reakcije ljubitelja poezije ali i ostale publike su uočene već na promociji zbirke 

(Slika 29). Ispred velikog broja okupljenih, osim pohvale autoru, zapažena je i estetska 

komponenta knjige koja se oslanja na sinergiju dviju umjetnosti – fotografije i književnosti. 

Vođena tim dojmom, zbirka „Nešto kao… sjećanja“ je predstavljena kao svojevrsna 

monografija i zbirka pjesama u jednom. 

U tehničkom smislu, u tiskari je došlo do kršenja zadanih zahtjeva, a vezano je za odabir 

vrste papira. Naime, zbog materijalnih troškova tiskalo se na lošijem i tanjem papiru od 

predviđenog pa se izgubilo na kvaliteti prikaza fotografije. Svi ostali zahtjevi su uvaženi te 

nije bilo nikakvih nejasnoća u procesu tiska. Knjiga je tiskana u nakladi od 500 primjeraka. 

 

Slika 29 Članak o promociji knjige (Večernji list, 2012., BiH) 
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4. ZAKLJUČAK 

Diplomski rad je prikazao faze nastanka stvarnog proizvoda - zbirke pjesama „Nešto kao… 

sjećanja“. Radi se o realiziranom autorskom grafičkom proizvodu, gdje sam osobno 

sudjelovala od početka njegova nastanka; snimanja i prikupljanja fotografija, pripreme 

dokumenta te naposljetku do samog reprodukcijskog procesa.  

U ulozi fotografa, pazila sam da zadovoljim estetske kriterije odabranih fotografija. Također 

sam uskladila prikaz motiva ilustracije s tematikom pjesme kojoj je dodijeljena. Kao grafički 

dizajner, mogu zaključiti da je, osim originalnih ideja i kreativnih sposobnosti, neophodno 

razumijevanje osnovnih načela reprodukcijskog procesa. Kolegiji na Grafičkom fakultetu su 

mi pružili temeljna znanja i vještine koje sam iskoristila pri oblikovanju spomenute knjige. 

Poseban naglasak sam dodijelila mogućnostima Adobovih programa pri radu s fotografskom 

ilustracijom i njenom komponiranju s tekstom autorovog rukopisa. 

Najvažniji zaključci ovog diplomskog rada vezani su za način snimanja fotografije, njene 

obrade u Photoshopu te pripreme Indesign dokumenta za tisak. Digitalnu fotografiju je 

najbolje snimati kao sirovu RAW datoteku. Minimalna rezolucija fotografije koja se 

priprema za tisak je 300 dpi a najbolje ju je pohraniti u TIFF slikovnom formatu. Za više 

stranični prijelom, najbolje je koristiti Adobov Indesign koji sprema konačni dokument u 

PDF format čitljiv tiskarskom stroju. Takav dokument mora biti spremljen u Press Quality 

opciji, zajedno s napustom i reznim markama.  
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